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ВВЕДЕНИЕ 
 

Современные методы экологического моделирования, основанные на ГИС-технологиях, 
позволяют выявить области, подходящие по своим климатическим характеристикам для про-
израстания того или иного вида или любого другого таксона, причем как в настоящее время, 
так и в прошедшие геологические периоды.  Особенно востребованы прогнозные карты веро-
ятного распространения тех или иных видов в будущем в соответствии с определенными сце-
нариями изменения климата. Следует, однако, подчеркнуть, что речь идет лишь о моделирова-
нии вероятностного распределения климатических условий, благоприятных для произрастания 
того или иного вида, а успех внедрения в растительные сообщества и закрепление в них зави-
сят в немалой мере и от других причин – конкурентной способности вида, его биологических 
особенностей, взаимосвязей компонентов сообщества. 

В настоящее время существует несколько методов биоклиматического моделирования. 
Как правило, они требуют географических координат не только тех пунктов, где вид присут-
ствует (был собран или зарегистрирован), но и точек, где он гарантированно отсутствует. Ра-
зумеется, такой подход применим только для хорошо изученных территорий и совершенно не 
подходит для исследований, проводимых в Сибири и Центральной Азии. Методов, использу-
ющих данные только о присутствии видов, не так много. Наиболее используемые – BIOCLIM и 
MаxEnt – реализуются и визуализируются в программе Diva-GIS. Эти методы относительно 
просты и в настоящее время широко используются. Существует множество пособий, помога-
ющих освоить и корректно использовать эти программы. Лучшими, на наш взгляд, являются 
пособия Scheldeman X. и Van Zonneveld (2010), Phillips и исследовательской группы AT and 
T. Research (Phillips, AT & T. Research, on line), Hjmans R.J., Guarino L., Jarvis A. et. al. (on line), 
Brown (on line), а также руководство R.J. Hijmans и J.Elith (2011), где можно найти дополни-
тельные пояснения, касающиеся освоения и корректного использования программы MaxEnt.  

К сожалению, практически все руководства по использованию этих методов изданы на 
английском языке, что нередко отпугивает студентов и ограничивает их исследовательские 
возможности. Наша задача – прописать алгоритм, облегчив студентам начальный этап освое-
ния метода. 

Большинство методов климатического моделирования основано на выявлении эколого-
климатической ниши исследуемых видов, которая устанавливается путем комбинации данных 
географического распространения видов (географических координат) и климатических харак-
теристик этих точек. Полученная модель затем проецируется на цифровую карту изучаемого 
региона. Она показывает потенциальное распространение вида и градацией тона от темного к 
светлому определяет области, где данный вид может произрастать и куда он может распро-
страниться в будущем (Ward, 2007). Более темным тоном на карте отмечаются области с 
наиболее благоприятными для каждого вида комбинациями климатических характеристик.  

Метод BIOCLIM, разработанный H. Nix (1986), широко используется для построения 
климатического профиля видов (его эколого-климатической ниши) и выявления их потенци-
альных ареалов. Он основан на построении «климатического конверта», в котором суммиру-
ются климатические данные точек, где вид был зарегистрирован. Основным достоинством ме-
тода является выявление и оценка климатических преференций вида (Beaumont et al., 2005). 

Метод MaxEnt (метод максимальной энтропии), предложенный S.J. Phillips (Phillips et. al., 
2006; Phillips, Dudic, 2008), в настоящее время является одним из самых эффективных методов 
моделирования распределения видов, когда в распоряжении исследователя есть только данные 
о присутствии вида и нет данных об его отсутствии (Giovanelli et. al., 2007; Elith et. al., 2006, 
2011; Franklin, 2009). Созданный для исследования биоразнообразия диких родичей культур-
ных растений, этот метод завоевал в настоящее время большую популярность и используется 
для изучения особенностей современного распространения редких, интродуцированных и чу-
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жеродных видов, а также для прогнозирования потенциальных возможностей их распростра-
нения (Hellmann et al., 2008).  

MaxEnt оценивает распределение подходящих условий обитания для исследуемого вида в 
соответствии с принципами максимальной энтропии. Энтропия в информатике является мерой 
непредсказуемости и неопределенности информации, или, другими словами, количество ин-
формации, которая содержится в случайной изменчивости или неизвестной величине (Ward, 
2007). Информационная и термодинамическая энтропия тесно связаны между собой, и получе-
ние информации влечет за собой потерю энтропии. MaxEnt рассчитывает распределение веро-
ятности ячеек растра, начиная с равномерного распределения, шаг за шагом уточняя соответ-
ствие модели введенным данным. Прирост начинается с нуля и асимптотически увеличивается 
в процессе расчета. Прирост определяется как средняя логарифмическая вероятность присут-
ствия объекта минус константа, которая делает прирост равномерного распределения равным 
нулю. В конце расчета прирост показывает, насколько сильно модель сконцентрирована вокруг 
«точек присутствия». Получающаяся на выходе карта показывает вероятность присутствия 
объекта на различных территориях. Метод хорош и тем, что позволяет оценить вклад каждой 
климатической переменной в полученную модель распространения вида, поэтому мы можем 
оценить роль каждого биологически значимого фактора, включенного в анализ. Кроме того, 
мы получаем ценную экологическую информацию, характеризующую виды.  

Оценка вклада каждой переменной производится в MaxEnt тремя независимыми спосо-
бами: прямой оценкой вклада в процентном отношении, оценкой после пермутации и с помо-
щью опции jackknife.  
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Глава 1. УСТАНОВКА ПРОГРАММНОГО ОБЕСПЕЧЕНИЯ 
 

1.1. Установка Diva-GIS 
 

Для установки программного обеспечения пройдите по ссылке http://www.Diva-
GIS.org/download и скачайте бесплатную версию, выбрав Diva-GIS 7.5. Сохраните файл в удоб-
ной для вас папке (например, C:\Program Files\ Diva-GIS).  

Выполните инсталляцию программы, выбрав: русский язык→Ok→Я принимаю усло-
вия→Далее→Установить→Завершить (отметив галочкой – запустить Diva-GIS). 
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1.2. Установка Java 
 

Для корректной работы MaxEnt необходимо установить Java, это также бесплатное про-
граммное обеспечение, которое можно загрузить с сайта http://www.java.com. Зайдите на сайт и 
выберите загрузить Java бесплатно→Install.  
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1.3. Установка MaxEnt 
 

Программное обеспечение MaxEnt загрузите с сайта 
http://www.cs.princeton.edu/~schapire/Maxent 

 
 

Заполните поля Name, Institution, E-mail и перейдите по ссылке «Accept terms and 
download». Загрузите zip file, разархивируйте и сохраните в удобной для доступа папке.  

 
 

Открытие программы осуществляется двойным нажатием на файл с расширением *.jar. 
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Глава 2. ПОДГОТОВКА И ВВОД ДАННЫХ  
в Diva-GIS и MaxEnt 

 
Для дальнейшего анализа и обработки данных к установленным программам необходимо 

дополнительно загрузить слои, содержащие биологически значимые климатические параметры 
(гл. 2.2), и шейп-файлы стран, континентов, рек и др. (слои для создания карт можно скачать с 
сайта http://diva-gis.org/Data).  

 

 
 

 
 

 
Начиная работать с данным программным обеспечением, необходимо учесть, что про-

грамма очень требовательна к организации и хранению данных. Всю информацию желательно 
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хранить в одной папке, которая подразделяется на 3: слои (layers), точки (samples) и выходные 
данные (output). В папке слои будут храниться данные о климате, в папке точки – подготов-
ленные данные о местонахождениях видов с координатами, в папке output автоматически со-
храняются результаты анализа MaxEnt. 

Подготовка и импортирование данных о распространении видов в Diva-GIS и MaxEnt – 
основа для выявления эколого-климатической ниши вида, построения модели его распростра-
нения и, наконец, пространственного анализа биоразнообразия. Для выявления точек местона-
хождения можно использовать свои собственные данные по распространению вида, гербарные 
материалы, а также базы данных, такие, например, как GBIF (http://www.gbif.org), и/или объ-
единить информацию из всех этих источников. Большая часть данных в GBIF – данные герба-
риев, которые могут не отражать нахождения таксонов в настоящее время из-за недавних из-
менений (например, сельскохозяйственной деятельности человека). Тем не менее такие данные 
могут быть полезны для изучения динамики растительного покрова.  

Все данные о местонахождениях видов должны быть специально подготовлены и быть 
соответствующего формата, необходимого для чтения Diva-GIS и MaxEnt. Таблица, содержа-
щая данные о местонахождениях видов, состоит из идентификационного кода (ID), видовой 
(таксономической) принадлежности образца и географических координат его местонахожде-
ния – широты и долготы. Туда же может быть по желанию включена и другая полезная инфор-
мация (тип растительного сообщества, тип почвы, дата сбора, название гербария, где хранится 
сбор, и т.д.).  

 
2.1. Подготовка данных о распространении вида 

 
Программное обеспечение Diva-GIS может обработать два различных типа простран-

ственных данных: векторные и растровые (рис. 1). 
Векторные данные состоят из ряда данных с привязкой к географическим координатам, 

которые формируют группы точек, линий или многоугольников. В этом руководстве примера-
ми векторных данных служат данные с привязкой к географическим координатам местонахож-
дений таксонов (точки) или административные единицы – слои с административными грани-
цами или границами континентов (многоугольники). Обычно используемый формат векторных 
данных – шейпфайл (shapefile). Шейпфайл состоит по крайней мере из трех файлов с одинако-
вым именем, но различным расширением: *.shp, *.shx и *.dbf. Эти три файла содержат важную 
информацию, но в диалоговом окне программы Diva-GIS отображается только *.shp, так как 
именно он осуществляет привязку к координатам. 

Растровые данные являются матрицами пикселей (также называемых ячейками), каждый из 
которых хранит определенное значение для области, соответствующей этому пикселю. Растровые 
данные состоят из двух файлов с расширением *.grd и *.gri; однако в диалоговом окне Diva-GIS 
отображается только файл *.grd. GRD файл содержит общую информацию растра: положение 
растровых углов, число колонок и рядов, размер ячейки; GRI файл содержит данные каждой раст-
ровой ячейки. Когда растровый файл импортируют в MaxEnt, рекомендуется использовать расши-
рение ASC II. Перевести GRD файл в файл с расширением ASC II можно в Diva-GIS.  

 
Рис. 1. Сопоставление растровой и векторной модели данных: А – векторный вид; В – растровый вид 
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Данные о состоянии окружающей среды в определенных географических областях также 
привязаны к географическим координатам и обычно организованы в растр. Растры состоят из 
сетки с ячейками идентичного размера, содержащими данные для переменной (например, 
среднегодовая температура, среднегодовые осадки и т.д.). В свободном доступе на сайте Diva-
GIS имеются 4 типа климатических данных, различающихся по размеру ячеек растра (табл. 1). 
Выбор размера ячейки зависит от задач исследования и площади территории (Scheldeman X., 
Van Zonneveld, 2010). Чем меньше территория, тем выше должно быть разрешение. 
Использование ячеек различного размера дает разное разрешение (чем мельче клетки, тем 
выше разрешение). Обычно используются ячейки 2,5 мин, равные на экваторе 5 км, или 30 с, 
равные на экваторе 1 км.  
 

Т а б л и ц а  1 
Размерность растра географических единиц 

 
Градус (на экваторе)1 Метрическое расстояние 

10 мин 
5 мин 
2,5 мин 
30 с 

18 км
9 км 
5 км 
1 км 

1 По направлению к полюсам метрические расстояния по долготе уменьшаются и на полюсах они равны 
нулю. 

 
2.1.1. Форматы данных и их организация 

 
Координаты местонахождений видов заносятся в таблицу Excel и затем преобразуются в 

соответствующие форматы, используемые программами Diva-GIS и MaxEnt. Diva-GIS приме-
няется для визуализации и пространственного анализа, а MaxEnt – для моделирования распро-
странения объектов.  

Diva-GIS и MaxEnt используют данные о широте (latitude) и долготе (longitude) в деся-
тичной системе (DD) – градусы и его десятичные доли (DD.DDDD). Если координаты пред-
ставлены в формате DMS – градусы, минуты и секунды (DD°MM’SS’’), или в формате DM – 
градусы, минуты и их десятичные доли (DD°MM.MM’), то они должны быть преобразованы в 
формат DD (градусы). Для преобразования данных используется следующая формула:  

 
Десятичные градусы = [(Градус (°) + Минуты (‘) / 60 + Секунды (“) / 3600)] × H, 

 
где H = 1, когда координата находится в Восточном (E) или Северном (N) полушарии, H = –1, 
когда координата находится в Западном (W) или Южном (S) полушарии. 

 

Долгота 
Градусы, мину-
ты и секунды 

Десятичное 
число градусов

Широта 
Градусы, ми-

нуты и секунды 
Десятичное чис-
ло градусов 

Восточное 
полушарие 

60°20’15’’ E + 60.3375 
Северное
полушарие 

24°00’45’’ N + 24.0125 

Западное 
полушарие 

60°20’15’’ W –60.3375 
Южное

полушарие 
24°00’45’’ S –24.0125 

 
Желательно, чтобы координаты в формате DD имели точность, по крайней мере, до четы-

рех десятичных знаков. Однако большее количество десятичных знаков, полученное в процес-
се преобразования данных из формата DMS в DD, производит впечатление ложной точности. 
Координата в формате DMS, включающая только минуты (например, 60°05’), имеет фактиче-
скую точность двух десятичных знаков, но может быть представлена в формате DD как коор-
дината с четырьмя десятичными знаками (60.0833). Когда данные о местонахождении включа-
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ют координаты в формате DMS меньше, чем с четырьмя десятичными знаками (только градусы 
и минуты или только градусы), то рекомендуется добавить дополнительную область, чтобы 
определить точность координат, прежде чем преобразовать их из DMS в формат DD. Преобра-
зование данных из DMS или из DM в формат DD производится в Excel. 

В дополнение к системе координат широта/долгота существует другая общепринятая си-
стема координат – Universal Transverse Mercator (UTM). Diva-GIS может использовать UTM, но 
система широта/долгота в формате DD предпочтительнее, так как она более совместима с до-
ступной информацией (административная информация о точке сбора, климат, растительный 
покров). Координаты UTM могут быть преобразованы в систему широта/долгота в десятичных 
градусах в Excel. Формулы для преобразования доступны в сети по адресу: 
http://www.uwgb.edu/dutchs/UsefulData/UTMFormulas.htm. 

Альтернативные способы представления информации. К сожалению, не всегда удает-
ся найти точные географические координаты пунктов сбора. В этом случае можно использо-
вать и административные единицы, но их нужно классифицировать: 

Страна 
Административная единица 1-го уровня: регион, провинция и т.д. 
Административная единица 2-го уровня: район.  
Место: город, село и т.д. 
В случаях, когда нет координат, а только населенный пункт, можно использовать базы 

данных или географические справочники. Географические справочники – это списки админи-
стративных единиц (населенных пунктов) с соответствующими координатами. Их можно 
найти on-line, например на веб-странице Diva-GIS: http://www.Diva-GIS.org/gdata. 

Файлы находятся в формате dBase IV (*.dbf), который может быть открыт в Excel (Schel-
deman X., Van Zonneveld, 2010). Однако не всегда данные о географическом пункте могут со-
держаться в базах данных. Информация о местоположении может отсутствовать или населен-
ный пункт мог быть переименован; к тому же несколько населенных пунктов могут иметь оди-
наковое название. В этой ситуации для определения хотя бы приблизительных координат мо-
гут помочь имеющиеся различия на более высоких административных уровнях, таких как 
Adm1 (регион).  

 
2.1.2. Преобразование данных из формата DMS в формат DD при помощи Excel 
 

Откройте файл Excel с координатами местонахождений видов (широта/долгота – lati-
tude/longitude) в формате DMS. Он должен содержать пять колонок: ID (идентификационный 
номер), species (вид), latitude (долгота), longitude (широта), country (страна), как в примере. 

 

 
 

Скопируйте таблицу на новый лист в этом же документе и на новом листе добавьте после 
колонок latitude и longitude по четыре новых пустых колонки. Таблица приобретет следующий 
вид:  
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В колонки D, E, F, G и H, J, K, L попадут преобразованные значения координат из коло-
нок C и H. Далее выделите колонку С, так, чтобы все значения были подсвечены. При помощи 
функций найти и заменить «° ’ ’’» заменяем на « , » и выделяем колонку.  

 

  
 

Во вкладке Данные выберите Текст по столбцам.  
 

 
 

В появившемся окне отметьте с разделителями.  
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Далее в разделе Символом-разделителем является отметьте запятая и затем – готово.  
 

 
 

Значения разбиваются на 4 столбца. Колонка C – Lat (широта) будет содержать информа-
цию, в каком полушарии расположена координата, если в северном полушарии, то N замените 
на 1, если в южном – то S замените на –1.  

 

 
 

То же самое проделайте для координат долготы, только в колонке I – Lon (долгота) – для 
восточного полушария E замените на 1, а для западного полушария W на –1.  

 

 
 

Теперь полученный результат разделения по колонкам перенесите на первый лист с изна-
чальной информацией и подпишите все колонки, как показано ниже. Затем проведите контроль 
и сравните колонку С с колонками D–G и колонку I с колонками J–M, так как в процессе кон-
вертации могло произойти смещение или возникнуть ошибки другого рода.  
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Таблица теперь выглядит таким образом: 
 

 
 

Для преобразования широты и долготы из DMS в DD в верхнюю строчку колонки H (dec-
imal degrees – DD) вставьте формулу (= +D2 * (E2 + (F2/60) + (G2/3600))). Для координат дол-
готы (longitude) соответственно будет (=+J2*(K2+(L2/60) +M2/3600))). 

Лучше не копировать эти формулы из руководства, а прописать самим. Далее, зацепив 
левой кнопкой мыши правый нижний угол ячейки с формулой, протяните ее вниз до последне-
го значения колонки с координатами. В результате формула, вписанная только в первой строке, 
распространится на все остальные и значения будут преобразованы во всем столбце.  

 

 
 

Таким образом, колонки H и N теперь содержат десятичные градусы. Значения после за-
пятой будут больше, чем четыре знака, хотя, как было указано выше, нежелательно оставлять 
более четырех знаков после запятой. Поэтому, выделив колонку H, нажмите на правую кнопку 
мыши и выберите Формат ячеек→Числовой→Число десятичных знаков: 4→OK.  
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Создайте в вашем документе Excel еще один лист и скопируйте в него следующие столб-
цы: ID, species, decimal degrees (latitude/longitude), country. Скопируйте преобразованные коор-
динаты в DD (из колонок H и N) и вставьте их в новый документ или лист, используя функ-
цию Специальная вставка →значения→OK.  

Это необходимо, так как Diva-GIS не может импортировать новые данные в формате 
DD, если они все еще представлены в виде формул! 

 

 
 

 
 

Теперь у вас получается таблица с 5 колонками, в которых C и D содержат координаты в 
формате DD. 
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База данных местонахождений готова для импортирования в Diva-GIS. Важно хранить 
оригинальные данные в формате DMS, чтобы отследить любые ошибки, которые могли воз-
никнуть в процессе преобразования координат. Таким образом, ваш документ теперь содержит 
3 листа. Первый – с исходными данными в формате DMS, второй – со всеми техническими 
преобразованиями и третий – с координатами в формате DD. 

 
 

2.1.3. Преобразование данных о местонахождениях из формата *.xls в *.shp  
в программе Diva-GIS 

 
Если вы работали в Excel 2007, то сохраните таблицу с данными о местонахождениях с 

расширением *.xls (Excel 1997-2003), потому что если Excel имеет расширение *.xlsx (Excel 
2007), данные не могут быть импортированы в Diva-GIS. 

Откройте Diva-GIS и перейдите во вкладку Data→Import Points→From Excel (.XLS).  
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Откроется окно Excel to Shapefile (points). 
В строке Excel spreadsheet выберите файл Excel с координатами местонахождений вида, 

который вы хотите импортировать в Diva-GIS. Преред процедурой импортирования файл Excel 
лучше закрыть. 

В строке Worksheet выберите страницу в Excel, которая содержит нужные данные. 
В X/ Longitude выберите столбец, содержащий координаты долготы. 
В Y/ Latitude выберите столбец, содержащий координаты широты. 
В файле Excel эти столбцы должны быть подписаны соответствующим образом и 

необходимо быть очень внимательными, чтобы не перепутать координаты местами. 
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Нажимите Save to Shapefile для того, чтобы создать векторный файл *.shp. Для проверки 
правильности точек можете перед сохранением нажать Show, точки просто визуализируются, 
затем их можно будет сохранить. 

 

2.1.4. Импортирование географических координат в MaxEnt 
 

MаxEnt – программа, предназначенная для моделирования распространения видов. Дан-
ные, импортируемые в MxeEnt, должны быть в формате Comma Separated Values (CSV) c рас-
ширением *.csv и содержать только три колонки: species, longitude, lаtitude (вид, долгота, ши-
рота). Начальная матрица с оригинальными данными должна быть сохранена, и дальнейшая 
трансформация данных будет проходить в новом файле. Алгоритмы преобразования данных в 
Excel 2007 и Excel 1997–2003 различаются.  

 
Алгоритм преобразования данных в формат Comma Separated Values (CSV) в Excel 1997–2003 

 

1. На новую страницу или файл Excel скопируйте столбцы: species, latitude, longitude. 
2. Выберите Tools→Options (Сервис→Настройки).  
3. В строке International tab (Международные разделители) выберите точку для отделения 

десятичных и запятую для отделения тысячных→OK. 
4. Сохраните новый файл с расширением *.csv. 
Откройте файл с расширением *.csv в Excel, чтобы убедиться, что все координаты имеют 

десятичные значения.  
 

Алгоритм преобразования данных в формат Comma Separated Values (CSV) в Excel 2007 
 

В верхнем левом углу Excel нажмите кнопку Office и перейдите в параметры Excel, затем 
выберете Дополнительно → Использовать системные разделители. В окошке разделитель це-
лой и дробной части выберите точку [1], чтобы отделить десятичные, а в разделитель разря-
дов – запятую [2], чтобы отделить тысячные →OK.  

 

 
 

Откройте файл с расширением *.csv в Excel, чтобы убедиться, что все координаты имеют 
десятичные значения.  
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Сохраненный документ с расширением *.csv открываем в Блокноте. 
Откройте Блокнот и, если увидите, что есть разделители «;» , то измените  их на запятую. Это 

делается с помощью вкладки правка → заменить, меняем «;»  на «,». Сохраните изменения.  
 

 
 

 
 

Откройте MaxEnt. В строке Samples нажмите на Browse и в диалоговом окне найдите 
файл с местонахождениями в формате *.csv. Если все сделано правильно, в левой части окна 
добавится имя вашего файла с галочкой. 
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2.2. Импортирование климатических данных в Diva-GIS 
 

Для построения прогнозных карт помимо данных о местонахождении вида необходимо 
загрузить климатические данные, которые можно найти на сайте www.Worldclime.org (по этой 
ссылке сайт не всегда открывается, и тогда можно воспользоваться другим путем: зайдите на 
сайт http://www.diva-gis.org/→ Free spatial data→ WorldClim). На первой странице этого сайта 
найдите вкладку Download, далее скачиваете файлы с информацией о климате. Ели выберете 
Current – загрузится информация о современном климате, Past – климаты геологического про-
шлого и Future – разные модели будущего климата. 

База данных содержит 19 биологически значимых климатических переменных:  
 

Bio1 Среднегодовая температура
Bio 2 Среднемесячная суточная амплитуда температуры
Bio 3 Изотермальность (BIO1/ BIO7) х 100
Bio 4 Сезонность температуры (коэффициент вариации)
Bio 5 Максимальная температура наиболее теплого месяца
Bio 6 Минимальная температура наиболее холодного месяца
Bio 7 Среднегодовая амплитуда колебания температуры (BIO5 –  BIO6) 
Bio 8 Средняя температура наиболее влажного квартала
Bio 9 Средняя температура наиболее сухого квартала
Bio 10 Средняя температура наиболее теплого квартала
Bio 11 Средняя температура самого холодного квартала
Bio 12 Среднегодовые осадки 
Bio 13 Осадки самого влажного месяца
Bio 14 Осадки самого сухого месяца
Bio 15 Сезонность выпадения осадков (коэффициент вариации)
Bio 16 Осадки самого влажного квартала
Bio 17 Осадки самого сухого квартала
Bio 18 Осадки самого теплого квартала
Bio 19 Осадки самого холодного квартала

 
Скачайте файл diva_worldclim_2-5min, разархивируйте его и сохраните в созданной ранее 

папке слои. 
Откройте Diva-GIS, выберите Tools→Options. 

 

 
 

В окне Options выберете вкладку Climate, в строке Folder пропишите путь, куда был со-
хранен разархивированный файл с климатическими данными. Ниже появляется индикатор 
worldclim_2-5. После этого нажмите кнопку Apply (применить) и Save (сохранить). После за-
вершения этой процедуры климатические данные будут интегрированы в Diva-GIS. Закройте 
окно Close и, еще раз зайдя в Tools→Options, проверьте правильность всех операций. Если все 
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сделано правильно, то все индикаторы должны быть заполнены, как в приведенном ниже при-
мере. Если строки в диалоговом окне Options по-прежнему пустые, повторите алгоритм, прове-
рив правильность расположения папки с климатическими данными, или удалите скачанный 
файл и повторите все операции этого раздела заново.  

 

 
 

2.3. Создание климатических слоев для МaxEnt 
 

О том, как загрузить основу для создания климатических слоев – информацию о климате 
всего земного шара, было сказано в предыдущем разделе. Теперь для использования климати-
ческих данных в MaxEnt необходимо создать климатические слои только для исследуемой тер-
ритории. Такая операция сокращает объем и время анализа.  

Для создания слоев для изучаемой территории необходимо выполнить следующий алго-
ритм: 

Пройдите во вкладку Data → Climate → Map. 
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В появившемся окне Climate Date to Map выберите Read from layer → Draw rectangle. 
Далее есть два пути: как ограничить пределы исследуемой территории: 
1) Прописать координаты, которые вы заранее выбрали, в окнах maxY, minY, maxX, 

minxX. 
2) После нажатия на Draw rectangle мышкой протянуть прямоугольник, включающий вы-

бранную территорию, и программа сама пропишет координаты углов этого прямоугольника. 
Однако он сразу исчезает и никак не визуализируется на этом этапе. 

 

 
 

 
 

Для определения пределов изучаемой области (территории) вводим координаты: Y – ши-
рота, X – долгота. В нашем примере это Y – 45–80, а Х – 60–165. 

В окне Climate database to map должно появиться worldclim_2-5m. Это совокупность кли-
матических параметров, рассчитанных для всей суши земли, из которой будут извлечены дан-
ные, касающиеся обозначенной вами территории. Единственная причина, по которой в окне 
может не появиться название нужной базы данных, это неправильно выполненный алгоритм в 
разделе 2.2.1. 

Далее в строке Output выберите нужный вариант:  
– если выбрать Altitude, то карта будет отображать рельеф; 
– если выбрать Bioclim, то отобразятся 19 биоклиматических параметров. Поставив га-

лочку около All, мы получим все предложенные переменные, но для анализа можем выбрать и 
отдельные желаемые параметры.  
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Выберите сначала Altitude. В строке File пропишите путь, куда сохранить полученные 
данные. Ранее мы уже создали три папки – слои, точки, выходные данные. Полученные для из-
бранной территории климатические данные следует сохранить в папке «слои» (layers). Далее 
нажимаем Apply – применить. Проверьте, сохранились ли созданные файлы в нужной папке.  

 
2.4. Визуализация результатов в Diva-GIS 

 
Теперь можно открыть полученные файлы в Diva-GIS и сделать полученную карту бо-

лее наглядной, изменив цвета и их градацию. Щелкните два раза на легенде выбранного для 
редактирования слоя (она отображается в левой колонке), и откроется окно Properties, в кото-
ром можно корректировать карту. 
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Этот алгоритм корректировки слоев идентичен для всех карт. Здесь, дважды нажав левой 
кнопкой мыши на цвета, выберите наиболее подходящий для каждого интервала оттенок. 
В дальнейшем вы сможете копировать цвета для легенды с ранее созданных вами карт, если их 
цветовая гамма подходит для новой карты. Для этого можно просто выбрать Read From File, 
щелкнув на файл со слоем, цвет которого вы хотите скопировать. Программа перенесет эти 
цвета и градацию на новую карту. Опция Ramp предусматривает автоматический подбор цве-
тов, но лучше это сделать вручную. 

Кроме того, если вам необходимо увеличить количество интервалов, чтобы переход от 
цвета к цвету был более плавным, можно, нажав на плюс под Add or Remove Row, добавить ин-
тервалы. Удалить их можно, нажав на минус, так же можно изменять числовые интервалы. Это 
основные преобразования карты, которые вам необходимы. 

 

 
 

Таким же образом вы можете изменить цвет, форму и размер точек. Если дважды щелк-
нуть по легенде слоя с точками [1], откроется окно Properties. В нем, еще раз щелкнув на точку 
[2], получим окно Symbol, где можно выбрать: Style – изменение формы значка, обозначающего 
места сбора [3]; Color – изменение цвета [4] и добавление контура (если поставим галочку око-
ло Outline, символ будет иметь контур), цвет которого также можно выбрать [5]. 
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Итак, в результате этой процедуры вы получаете основу (климатическую или высотную) 
для дальнейшего анализа. Если все сделано правильно, в папке cлои (layers) появится файл с 
рельефом не для всей суши, а только для выбранной территории. 

Откройте и посмотрите результат, добавив в Diva-GIS созданные слои. Нажмите Add lay-
er, выберете в папке layer созданный слой с рельефом и нажмите «открыть». Если открыть все 
19 биоклиматических параметров, то все переменные визуализируются на карте и будут пере-
крывать друг друга. Поэтому, открыв все слои и убрав на левой панели галочки напротив Bio 
1…Bio19, попеременно включая их, можно посмотреть результат для каждой переменной. 

Для того чтобы биоклиматические данные были совместимы с MaxEnt, необходимо кон-
вертировать их в файл с расширением ESRI. Для этого необходимо перейти во вкладку Da-
ta→ExportGridfile→ Multiple files. 
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В этом окне выбираете расширение ESRI ASCII и, через Add file,  слои BIO1–BIO19, ко-
торые вы «вырезали» и сохранили в папке слои. Затем кликаете на Apply.  

 

 
 

 
 

Таким образом, теперь вы имеете все необходимые данные для дальнейшего анализа и 
моделирования. 

 
2.5. Контроль качества данных, используемых для построения модели 

 
Качество полученной модели напрямую зависит от качества введенных данных. Выше 

описаны только самые простые приемы подготовки данных, однако для публикации результа-
тов необходима более тщательная подготовка и данных о распространении вида, и климатиче-
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ских характеристик. Например, следует учесть разницу метрических расстояний по долготе, 
которые уменьшаются от экватора к полюсу. Это особенно важно, если исследуемые ареалы 
вытянуты вдоль меридиана. Следует также избегать использования в анализе скоррелирован-
ных эколого-климатических данных, многие из которых обнаруживают высокую взаимозави-
симость (Scheldeman, Van Zonneveld, 2010; Brown, 2014). Возможны ошибки и неточности при 
определении точек присутствия. Они могут быть двух типов: это ошибки в идентификации ма-
териала (в базах данных могут содержаться неточно или неправильно определенный материал, 
может измениться таксономический статус изучаемой группы) и ошибки или неточности при 
определении географических координат. Точность координат может оцениваться путем анали-
за метода, которым они были получены (например, координаты, определенные по картам и с 
помощью GPS), или в соответствии с количеством знаков после запятой. Ошибки координат, 
анализируемых данных неизбежно приведут к ошибкам в выходных данных и негативно отра-
зятся на результатах анализа. Программное обеспечение Diva-GIS имеет некоторые полезные 
инструменты для выявления возможных ошибок в координатах на основании существующей 
информации об административных единицах или для выявления подозрительных точек при-
сутствия на основании атипичных условий окружающей среды, которые могут указывать на 
таксономически неправильную идентификацию или ошибочные координаты (Scheldeman, Van 
Zonneveld, 2010). 

Поскольку MaxEnt в настоящее время признан одним из лучших алгоритмов для модели-
рования ареалов видов, он динамично развивается, разработчиками принимаются во внимание 
все новые аспекты, появляются новые возможности, существенно повышающие качество мо-
дели. Такие дополнительные возможности реализованы в программе SDMtoolbox (Brown, 
2014), которая является свободно распространяемым приложением к лицензионной программе 
ArcGIS (ESRI ArcGIS, 2012), при этом версия должна быть не ниже ArcGIS 10. Улучшения ка-
саются как данных о присутствии, так и климатических характеристик. Для того чтобы повы-
сить качество точек присутствия, эта программа учитывает особенности географической си-
стемы координат, при которой площадь, заключенная между отрезками параллелей и меридиа-
нов, меняется в широтном направлении за счет схождения меридианов у полюсов. В связи с 
этим для корректного использования программы MaxEnt, предусматривающей образование 
«фоновых» точек (точек псевдоотсутствия), необходимо обеспечить смещение этих фоновых 
точек. Уровень этого смещения зависит о ширины исследуемой области в широтном направле-
нии. Программа предлагает два пути решения этой проблемы, а специальное руководство, раз-
мещенное в сети (Brown, on line), подробно описывает алгоритм действий.  

Известно, что распределение выявленных «точек присутствия» в немалой степени зави-
сит от близости к дорогам и населенным пунктам, что искажает истинную картину распределе-
ния видов в природе и негативно влияет на результаты анализа. Особенно ощутимо это на ма-
лоисследованных территориях, в частности в Сибири, где точки расположены в основном в 
южной, наиболее населенной части, и группируются возле населенных пунктов, вдоль дорог и 
больших рек. Существующие в настоящее время приемы позволяют существенно снизить вли-
яние такого избирательного отбора образцов.  

Другая проблема – корреляция между биоклиматическими данными. Как уже отмечалась, 
высокая корреляция между ними сильно затрудняет, а нередко делает невозможной правиль-
ную оценку вклада каждой переменной в построенную модель распространения вида. 
SDMtoolbox позволяет снизить корреляцию между климатическими характеристиками путем 
выявления и удаления высокоскоррелированных переменных (Brown, on line).  
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Глава 3. ОПРЕДЕЛЕНИЕ КЛИМАТИЧЕСКОГО ПРОФИЛЯ ВИДА  
(ЭКОЛОГО-КЛИМАТИЧЕСКОЙ НИШИ) 

 
Как известно, современные очертания ареала вида и его изменения на протяжении гео-

логических периодов в существенной мере обусловлены экологическими и климатическими 
причинами. Поэтому выявление эколого-климатической ниши видов или подвидов является 
важной составляющей биогеографических исследований. Климатический профиль вида, опре-
деляемый на основании климатических данных, нередко называют экологической нишей, од-
нако это вряд ли можно признать корректным. Термин «экологическая ниша» был введён в 
1914 г. Дж. Гриннеллом, который понимал под экологической нишей место, занимаемое видом 
в биоценозе, включающее комплекс его биоценотических связей и требований к факторам сре-
ды (Hutchinson, 1991; Джиллер, 1988; Грант, 1980). Однако в настоящее время этот термин раз-
ными авторами трактуется неоднозначно: под экологической нишей понимается и сумма фак-
торов существования данного вида, основным из которых является его место в пищевой цепоч-
ке, и совокупность всех факторов среды, в пределах которых возможно существование вида в 
природе. Преобладающей в настоящее время является модель Дж.Э. Хатчинсона. Он рассмат-
ривал экологическую нишу как n-мерную модель. В этой модели каждому фактору среды соот-
ветствует ось абстрактного гиперпространства, т.е. пространства с числом осей больше 3. 
В этом гиперпространстве каждый вид занимает определенный гиперобъем. Гиперобъемы раз-
ных видов перекрываются, но не совпадают. Согласно Хатчинсону, экологическая ниша может 
быть фундаментальной – определяемой сочетанием условий и ресурсов, позволяющим виду 
поддерживать жизнеспособную популяцию, и реализованной – свойства которой обусловлены 
конкурирующими видами. При этом факторы независимы друг от друга и реакция на один 
фактор не зависит от воздействия другого фактора (Грант, 1980).  

В соответствии с общепринятыми представлениями экологическая ниша предусматри-
вает учет воздействия таких факторов, как увлажнение, освещение, температурный режим 
непосредственно в пунктах произрастания растения, и определяется с помощью экологических 
шкал (Раменский и др, 1956; Цаценкин, 1967; Селедец, Пробатова, 2007). При этом опосредо-
ванно принимаются во внимание влияние микро- и мезорельефа, затенения, уровня грунтовых 
вод, гранулометрического состава почвы. Такой подход требует очень детальных инструмен-
тальных исследований или применения трудоемких биоиндикационных методов. В свою оче-
редь, эколого-климатическая ниша или климатический профиль вида основаны на выявлении 
климатических характеристик точек, где был отмечен изучаемый вид. Биологически значимые 
климатические данные, полученные метеостанциями и экстраполированные на большие терри-
тории, отражают лишь общие тенденции изменения основных экологических факторов, и не 
учитывают особенностей отдельных местообитаний. Особенно сильно это проявляется в гор-
ной местности, где условия увлажнения и температуры могут кардинально изменяться на рас-
стоянии в несколько метров. Таким образом, нишу, получаемую с помощью описываемых 
ГИС-технологий, правильнее было бы называть не экологической, а эколого-климатической.  

Каждый вид адаптирован к определенному диапазону изменчивости климатических 
условий. Оценить его по каждому параметру в отдельности и сравнить у разных видов позво-
ляет программа BIOCLIM. Она визуализирует занимаемую видом экологическую нишу двумя 
путями: в виде гистограммы и «конверта». Гистограмма показывает частоты различных клима-
тических параметров, наблюдаемых у вида в заданной области. По оси абсцисс показана 
напряженность фактора, а по оси ординат – частоты (рис. 2).  

Еще один хороший инструмент для выявления эколого-климатической ниши таксона – 
климатический конверт. Он позволяет визуализировать двумерную нишу на основании двух 
климатических переменных. Ограничение эколого-климатической ниши вида основано на вы-
явлении климатических характеристик точек, где был отмечен изучаемый вид, и построении на 
этой основе так называемого «климатического конверта», прямоугольника в координатах кли-
матических переменных, ограничивающего пределы произрастания вида. 
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Рис. 2. Гистограммы частот климатических параметров 
 

Голубым прямоугольником внутри «конверта» обозначается область, куда попадают зна-
чения, не выходящие за пределы 5–95 процентилей. Зеленые точки внутри голубого прямо-
угольника климатической ниши представляют точки присутствия, климатический профиль ко-
торых по всем 19 биологически значимым климатическим параметрам лежит в обычных пре-
делах для данного вида. Красные точки на графике означают точки присутствия, у которых 
значения одной или нескольких из 19 климатических переменных выходят за пределы измен-
чивости, характерной для вида. Красные точки внутри голубого прямоугольника означают точ-
ки присутствия, у которых значения переменных, по которым строится график, лежат в уста-
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новленных для вида пределах, а значения хотя бы одной из оставшихся 17 переменных выхо-
дят за эти пределы (Scheldeman, Van Zonneveld, 2010).  

Далее изображены два двумерных графика Poa compressa L., построенных на основании 
двух климатических переменных. Слева – среднегодовая температура воздуха и среднегодовые 
осадки; справа – средняя температура наиболее теплого квартала и среднегодовые осадки 
наиболее теплого квартала. 

 

 
 

Для построения двумерных графиков и многомерного анализа можно также извлечь кли-
матические характеристики, непосредственно привязанные к местонахождениям видов. По-
скольку климатические данные представлены в растровом формате, потребуется выполнение 
специальных действий как с векторными, так и с растровыми данными. Здесь будет показано, 
как это сделать на примере злака Leymus chinensis (Trin.)Tzvel.  

Для того чтобы извлечь биоклиматические данные для каждой точки присутствия, от-
кройте слой «точки» в Diva-GIS и войдите в Data. Затем перейдите в Extract value by points и 
выберите From Grid or Stark.  
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В первой строке выплывающего окна укажите, откуда будут извлекаться данные для при-
вязки (точки присутствия). Во второй – отметьте растр, из которого будут извлекаться биокли-
матические данные. В третьей строке выберите опцию Grid. 

 

 
 

В строке Output выберите и обозначьте название выходного файла, который будет в тек-
стовом формате (* .txt). Также отметьте Single file и Values separated by lines. В окне include 
field выберите Species или ID (идентификационный вектор, служит для привязки полученного 
текстового файла к точкам присутствия). После того как окно будет заполнено, нажмите Apply.  

Полученная в результате таблица будет содержать значения выбранного климатического 
параметра (в данном случае Bio1) для всех наблюдаемых точек.  
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Полученную таблицу следует скопировать в Excel, не забывая при этом указать цифровой 
формат ячеек.  

Таким образом, можно извлечь значения любого из 19 биоклиматических параметров.  
Можно извлечь и сразу все 19, а помимо этого – минимальную и максимальную темпера-

туру, осадки и высоту над уровнем моря. Для этого следует повторить процесс: также в верх-
нем меню выбираем Data, переходим в Select Extract value by points, но выбираем From Climate 
data.  

 

 
 

В первой строке открывшегося окна надо указать шейп-файл точек присутствия, во вто-
рой – название результирующего файла. Далее указать базу данных, из которой будут выби-
раться климатические данные. Ее название должно точно соответствовать названию климати-
ческой базы данных, которая была введена в системный файл Diva-GIS (в данном случае – 
worldclim_2-5). 

В следующем окне надо отметить желаемые характиристики – высоту над уровнем моря 
(Altitude), минимальную (minimum temperature) и максимальную (maximum temperature) темпе-
ратуры, осадки (precipitation) и, наконец, Bioclim, содержащий все 19 климатических призна-
ков. Полученная в формате *.txt таблица будет громоздкая и трудно читаемая. Для удобства ее 
можно перенести Excel, где все данные будут размещены в соответствующих колонках.  

Данные из Excel можно перевести в Statistica software version 9.1 (Statsoft Inc. 2011) и ис-
пользовать их для построения категоризованных графиков и проанализировать как обычную 
матрицу данных, используя анализ главных компонент и факторный анализ. 



34 

 
 

 
 



35 

Глава 4. МОДЕЛИРОВАНИЕ РАСПРОСТРАНЕНИЯ ВИДОВ 
 

 

Современный научный подход к исследованию распространения видов предполагает вы-
явление не только современного ареала, но и потенциальных возможностей их распростране-
ния (Anderson, 2003), или потенциальных ареалов. Особенно важно это при изучении инвазив-
ных, а также редких видов.  

Понятие потенциального ареала вида было дано Т.А. Работновым (1983). Под ним пони-
мается область, где климатические условия благоприятны для произрастания вида. Эта харак-
теристика вплотную приближается к понятию экологического ареала, сформулированного 
В.П. Селедцом и Н.С. Пробатовой (2007). Однако, в отличие от экологического ареала, кото-
рый значительно более детально характеризует условия среды произрастания, выявление по-
тенциального ареала не требует детального исследования и определения места вида в коорди-
натах экологических шкал. Потенциальный ареал опирается на климатические показатели и 
может быть определен с помощью биоклиматического моделирования, основанного на исполь-
зовании ГИС-технологий.  

Биоклиматическое, или, как его еще иногда называют, эколого-климатическое моделиро-
вание распространения видов, основанное на использовании климатических показателей и 
ГИС-технологий, может выявить территории, подходящие по своим климатическим характери-
стикам для произрастания того или иного вида. Методы биоклиматического моделирования 
широко используются не только для исследования климатических потребностей вида, но и для 
моделирования возможных областей его произрастания в настоящее время. Основываясь на 
полученных данных и используя климатические параметры прошлых геологических эпох и 
модели будущих климатов, можно с известной долей вероятности выявить области распро-
странения изучаемого вида как в прошлом, так и в будущем (Hijmans et al., online).  

В предыдущих главах прописаны все этапы необходимые для начала работы в МaxEnt: 
– установлена программа МaxEnt,  
– созданы 3 папки: «точки» (samples), где хранятся соответствующим образом подготов-

ленные данные о распространении вида; «слои» (layers), где содержатся подготовленные и 
адаптированные для нашей территории биоклиматические данные и высоты; «выходные дан-
ные» (output), где появятся и будут сохраняться результаты моделирования.  

Запустите программу МaxEnt – откройте файл maxent.jar. Открывшееся окно программы 
состоит из двух частей. В левой его части – Samples – данные о присутствии объектов в тех или 
иных географических пунктах (точки присутствия). Здесь надо будет обозначить файлы, со-
храненные в папке «точки» (samples).  
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Загрузите данные, подготовленные по алгоритму, прописанному в гл. 2.  
В окне Samples щелкните на Browse (просмотр) и выберите папку samples, где хранятся 

подготовленные данные о распространении вида с расширением *.csv. В строке File появится 
путь к этой папке, например D:\maxent\samples\S.capillata.csv, а в прямоугольнике ниже по-
явится название файла. Порог 10 процентилей устанавливается по умолчанию. Это означает, 
что 10% точек присутствия, находящихся в предельных климатических условиях существова-
ния данного вида, считаются находящимися в нетипичных для вида условиях обитания и кли-
матические характеристики этих точек не принимаются во внимание при расчете климатиче-
ской ниши.  

В правой части окна – Environmental layers – загружаете климатические параметры, кото-
рые хранятся в папке layers. Щелкните на Brows и выберите из папки переменные Bio1 – Bio19, 
которые содержат информацию о климате только для территории исследования (гл. 2). Если 
все сделано правильно, то они визуализируются ниже. Если вы не хотите использовать все 
19 переменных (рекомендуется использовать только независимые переменные), отмечаете га-
лочками только те, которые намереваетесь включить в анализ. 

 

 
 

В Output directory прописывается путь к папке, где будут сохраняться все полученные ре-
зультаты. Щелкаете на Browse, выбираете папку output, которую предварительно создали. За-
тем в квадратиках справа отмечаем make pictures of predictions (с помощью этой функции будет 
создана карта предсказанного ареала вида в формате *.png и сохранена в папке output) и Do 
jackknife to measure variables (с помощью данной функции создается документ, содержащий 
анализ jackknife, о котором будет рассказано ниже). В строке Output format оставляем значение 
Logistic и в Output file type – *.asc (формат, в котором будет сохранен результат анализа). Если 
не была проведена предварительная подготовка «точек присутствия» с помощью SDMtoolkit, 
необходимо исключить из анализа данные, попадающие в одну и ту же ячейку растра. Для это-
го необходимо изменить настройки. Щелкните по кнопке Settings (настройки) и вызовите окно, 
в котором выбираете необходимые параметры. Здесь отметьте Remove duplicate presence rec-
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ords. Это позволит минимизировать сдвиг, обусловленный большой концентрацией данных в 
сходных климатических условиях.  

Кроме этого, следует учитывать, что данные о распространении должны быть распреде-
лены по возможности равномерно.  

 

 
 

Для того чтобы иметь в дальнейшем возможность оценить полученную модель, надо со-
здать тестирующую выборку. Для этого в строке Random test percentage, где по умолчанию 
стоит 0, следует вписать «25». Тогда из всего массива «точек присутствия» программа случай-
ным образом отберет 25% для последующего тестирования полученной модели. Таким обра-
зом, 75% данных будут использоваться для создания модели в качестве обучающей выборки, а 
25% – как тестирующая выборка. 

МaxEnt поддерживает три выходных формата значений модели – исходный, кумулятив-
ный и логистический. Все они связаны между собой, но по-разному масштабированы и по-
разному интерпретируются. По умолчанию результаты выдаются в логистическом формате. 
В приближенном виде он дает оценку вероятности произрастания вида в конкретной географи-
ческой точке от 0 до 1. При этом надо учитывать, что вероятность произрастания в немалой 
мере зависит и от того, как собирались данные: время наблюдения, размер участка, что осо-
бенно важно для мобильных видов. 

После того как сделаны основные настройки, запускаете процесс анализа – Run. О том, 
что процесс пошел, свидетельствует узкое окно, в котором отображается процент выполненно-
го анализа. 

Если территория исследования была очерчена не точно, какие-то точки могут оказаться 
вне этой территории и к ним нельзя будет привязать климатические данные. В таком случае в 
ходе работы появятся предупреждения о том, что какие-то данные (точки, координаты) выхо-
дят за пределы выбранной вами территории. После того как процесс будет завершен, узкое ок-
но исчезнет, останется только окно программы МaxEnt. 
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Это значит, что анализ завершен и можно ознакомиться с результатами, которые сохра-
нены в папке output. Откройте папку и выберите файл с расширением *.html. Полученная мо-
дель (в нашем примере для Stipa capillata L.) будет содержать 4 раздела: статистический анализ 
точности модели, карту потенциального распространения вида, анализ вклада использованных 
в анализе климатических переменных в полученную модель и контрольные параметры выбо-
рок и модели. Помимо этого, папка output будет содержать папку plots, в которой собран иллю-
стративный материал в формате *.png. Его можно открыть в любом графическом редакторе.  

Карта потенциального распространения вида, сохраненная в output-файле, показывает, 
насколько различные территории пригодны по своим климатическим характеристикам для оби-
тания вида. Кумулятивные выходные данные могут быть интерпретированы как предсказание 
подходящих условий произрастания вида выше установленного порога 10 процентилей (цвето-
вой градиент от желтого до темно-бордового на иллюстрации). Градиент цветов показывает, где 
условия для произрастания вида являются более благоприятными. Так же можно сделать карту 
монохромной и только в оттенках серого показать этот градиент. 

Ниже представлен исходный формат, находящийся в папке outpute → plot и в документе 
*html.  
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Глава 5. ОЦЕНКА ПОЛУЧЕННОЙ МОДЕЛИ 
 

Для оценки прогностических возможностей моделей, построенных при помощи МaxEnt, 
используется несколько параметров. Часто для анализа применяется порог (threshold) бинари-
зации предсказания: условия считаются пригодными для существования вида, если предсказа-
ние выше некоторого порогового значения, и непригодными, если ниже. Обыкновенно прини-
мается порог 10 процентилей. Это означает, что 90% точек присутствия, включенных в анализ, 
попадают в «потенциальный ареал». Оставшиеся 10%, не попадающих в эту область, расцени-
ваются как произрастающие в атипичных условиях и не учитываются при построении клима-
тической ниши.  

При построении модели возможны два типа ошибок: omission (омиссия) – доля присут-
ствующих, предсказанных, как отсутствующие, и commission (комиссия) – доля отсутствую-
щих, предсказанных, как присутствующие.  

Первый график – Omission and predicted area – показывает, как меняются омиссия и пред-
сказанная территория по обучающим точкам присутствия и тестирующим точкам в зависимо-
сти от кумулятивного порога. Красная кривая (fraction of background predicted) отражает долю 
«фоновых» точек, включенных в смоделированную область распространения ниже изменяемо-
го кумулятивного порога. Синяя линия – омиссия обучающей выборки (оmission on training 
samples) – характеризует работу модели и показывает долю точек присутствия, выходящих за 
пределы области, смоделированной МaxEnt, от нижнего до верхнего порога значений, ограни-
чивающих предсказанную область присутствия (кумулятивный порог). Голубая линия – омис-
сия тестирующей выборки (оmission on tasting samples). Черная линия – предсказанная омиссия 
(Predicted omission).  

 
 

В данном случае график показывает, что омиссия по тестовым точкам довольно хорошо 
совпадает с предсказанной динамикой омиссии, рассчитанной для тестовых данных, получен-
ных из самого распределения MaxEnt.  

Очень важными показателями являются Receiver Operating Curve (ROC) и площадь про-
странства под этой кривой – Area Under the curve (AUC). ROC – график, позволяющий оценить 
качество бинарной классификации. Он отражает соотношение между долей объектов от обще-
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го количества носителей признака, верно классифицированных как несущих признаки (ось ор-
динат), и долей объектов, не несущих признаки, ошибочно классифицированных как несущие 
признак (ось абсцисс). Количественную интерпретацию ROC дает показатель AUC – площадь, 
ограниченная ROC и осью доли ложных положительных классификаций (долей объектов, не 
несущих признаки, ошибочно классифицированных как несущих признак). AUC – это оценка 
способности модели указывать присутствие вида в той точке растра, где он с высокой долей 
вероятности должен находиться. AUC измеряет способность модели различать ячейки растра, 
где вид присутствует и где он отсутствует, обеспечивая измерение общей точности, не зависи-
мое от порога. AUC является мерой площади под ROC, начиная от 0,5 (случайная точность) до 
1 (идеальная дискриминация). В случае если AUC равна или ниже 0,5, модель не имеет ника-
кой прогностической ценности. Значение 0,8 для AUC означает 80%-ную вероятность того, что 
там, где предсказано нахождение вида, он действительно будет находиться1. М.В. Araújo 
(Araújo et al., 2005) предлагает следующую интерпретацию AUC для полученных моделей: 
свыше 0,9 – отличная, равная или менее 0,9, но более 0,8 – хорошая, равная или менее 0,8, но 
более 0,7 – приемлемая, равная или менее 0,7, но более 0,6 – плохая и, наконец, равная или ме-
нее 0,6, но более 0,5 – недействительная.  

График AUC состоит из трех линий. Красная кривая (ROC) ограничивает AUC. Чем бли-
же к верхнему левому углу находится эта линия, тем больше площадь под кривой, тем лучше 
модель предсказывает точки присутствия, содержащиеся в тестирующей выборке. Синяя кри-
вая показывает, насколько хорошо модель описывает обучающую выборку. Черная прямая 
ограничивает площадь, ниже которой дискриминация не выше случайной (Phillips, 2006; 
Scheldeman, Van Zonneveld, 2010). 

 

 
 

 

                                                             
1 В данном случае модель показывает не нахождение вида, которое помимо климатических зависит от многих 
других условий, а соответствие территории его климатическим потребностям. 
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Глава 6. ОЦЕНКА ВКЛАДА БИОЛОГИЧЕСКИ ЗНАЧИМЫХ  
КЛИМАТИЧЕСКИХ ПЕРЕМЕННЫХ В ПОСТРОЕНИЕ МОДЕЛИ 

 
Программа MaxEnt позволяет произвести оценку вклада каждой переменной в модель 

распространения тремя способами – путем прямой оценки вклада в процентном отношении, 
оценки после пермутации, и с использованием приема jackknife. Результаты прямой оценки и 
оценки после пермутации помещены в output файл в виде таблицы. В данном случае, чтобы 
минимизировать влияние корреляции, после проведения специальной процедуры в анализ бы-
ло включено только 8 переменных). 

В процессе «обучения» модели программа отслеживает, какой вклад вносят переменные в 
построение модели. В конце этого процесса происходит перерасчет приростов каждой пере-
менной в проценты, и эти проценты приводятся во второй колонке таблицы (табл. 2). При этом, 
как указывают разработчики программ (Phillips, АT and T Research, on-line), эти вклады опре-
деляются чисто эвристически и во многом зависят от конкретного пути, по которому пошел 
MaxEnt. Если бы он пошел по другому пути, проценты при том же самом конечном результате 
(модели распространения вида) могли бы быть другими. Разработчики программы советуют 
особо осторожно подходить к оценке вклада сильно скоррелированных переменных, а лучше 
их вообще не использовать.  

Третья колонка включает оценку переменных после пермутации (permutation – переста-
новка). Вклад каждой переменной определяется путем случайного изменения значения этой 
переменной в анализе, включающем все данные, принимающие участие в процессе «обуче-
ния»: и точки реального присутствия вида, и «фоновые». При этом значение каждой перемен-
ной выражается в изменении обучающей AUC. Чем сильнее уменьшится значение AUC, тем 
сильнее зависит модель от этой переменной. Для того чтобы выразить это влияние в процен-
тах, значения нормализированы.  

 
Т а б л и ц а  2 

Вклад переменных в построение модели 
 

 
Данная таблица показывает, что после пермутации роль Biо1 и Bio12, означающих, соот-

ветственно, среднегодовую температуру и среднегодовые осадки, поменялась, а на третье ме-
сто вышла переменная Bio15 (сезонность осадков), которая при прямой оценке занимала лишь 
шестую строчку. Особое значение этого подхода состоит в том, что оценка вклада зависит 
только от окончательной модели, а не от пути, по которому шло ее построение.  

Еще один способ оценки вклада переменных в результирующую модель, реализуемый в 
программе MaxEnt, – прием jackknife. Он состоит из трех шагов. Сначала по очереди из анализа 
исключаются все переменные, кроме анализируемой, и модель создается с оставшимися. Затем 
модель создается только с одной переменной (с каждой по очереди). И, наконец, для сравнения 
создается модель с участием всех переменных. Результаты этого анализа показаны на столбча-
тых диаграммах в файле output. Отдельно приводятся диаграммы для проверки прироста тесто-
вых данных, обучающих данных и AUC. Надо отметить, что роль переменных в разных диа-
граммах может изменяться.  
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Синие (более темные и короткие) столбцы показывают роль переменной при построении 
модели только с этой переменной, голубые (более светлые и длинные) – с исключением этой 
переменной, и красным (самый нижний столбец) – с включением всех переменных. Сильное 
уменьшение голубого столбца означает, что исключение этой переменной ведет к серьезному 
ухудшению модели. Чем короче этот столбец, тем больше уникальной информации содержит 
переменная. И наоборот – если голубой столбец превышает красный, это значит, что включе-
ние этой переменной только ухудшает модель.   

 

 
 

В данном случае Вio2 (суточные колебания температуры) почти не дают прироста, и ис-
пользование одной этой переменной для моделирования пространственного распространения 
вида бесполезно. При этом Вio1 (среднегодовая температура) показывает достаточно хорошие 
результаты. Если же рассматривать построение моделей с исключением переменных (голубые 
столбцы), то видно, что ни одна переменная не содержит значительного количества уникаль-
ной информации. Некоторое, не очень большое количество такой информации содержит Bio12 
(вторая диаграмма), но в целом выключение каждой переменной не приводит к существенному 
уменьшению прироста (Phillips, АT and T Research, on-line). 

Помимо создания моделей современного распространения видов, MaxEnt может генериро-
вать модели вероятного распространения видов в прошлом и будущем, используя соответ-
ствующие климатические характеристики, доступные на сайте Worldclim.org. Для этого произ-
водится соответствующая подготовка климатических данных, затем строится модель совре-
менного распространения. Подробное описание необходимых действий содержится в руковод-
стве Guidebook for MaxEnt (Phillips, АT and T Research, on-line).  
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Глава 7. ВИЗУАЛИЗАЦИЯ И РЕДАКТИРОВАНИЕ РЕЗУЛЬТАТОВ,  
ПОЛУЧЕННЫХ в MaxEnt, в программе Diva-GIS 

 
7.1. Визуализация результатов 

 
Файл, описывающий модель распространения вида, полученный в результате анализа 

MaxEnt, сохраненный в папке output, имеет расширение *.asc, а Diva-GIS поддерживает файлы 
с расширением *.grd. Поэтому необходимо файл с расширением *.asc перевести в формат *.grd. 
Для этого открываете вкладку Data, далее выбираете Import to Gridefile и отмечаете Single File. 
 

 
 

В появившемся окне выбираете тип файла ESRI Ascii. Здесь важно проследить, чтобы оп-
ция Save as integer не была выбрана по умолчанию.  

В строке Input File выбираете файл из папки output с результатами MaxEnt. 
В строке Output File автоматически появляются такой же путь и файл, но с расширением 

*.grd. Если вы хотите сохранить файл в другой папке, просто пропишите путь вручную.   
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После нажатия на OK файл сохраняется в папке output и открывается карта. Полученная 
карта моделирования ареала отражает пригодность различных областей для произрастания 
данного вида.   

 

 
 

В легенде слева от слоя карты указывается градация вероятности произрастания вида. За-
давая параметры анализа MaxEnt, вы по умолчанию задали порог в 10 процентилей. Это зна-
чит, как уже отмечалось выше, что 10% точек не включаются в анализ и соответствующие им 
местообитания расцениваются как нетипичные. Этот порог должен быть визуализирован на 
карте. Пороговое значение для 10 процентилей обучающей выборки указано в таблице порого-
вых значений. Эта таблица вместе с другими результатами появляется по окончании анализа в 
папке output *.html. По таблице находите пороговое значение. Таблица содержит кумулятив-
ный и логистический пороги. Для визуализации выбираете логистический формат. В нашем 
случае оно составляет 0,199.  

 

 
 

Затем открываете легенду растра и создаете новый класс, от 0 до порогового значения (в 
нашем примере 0–0,199). Лучше выбрать для него какой-нибудь нейтральный цвет. Этим цветом 
будут обозначены территории, климатические условия которых будут оцениваться как не подхо-
дящие для вида и выходящие за пределы его эколого-климатической ниши. Визуализация может 
быть улучшена путем модификации стандартной легенды, как было указано в разделе 2.2.3. 
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Diva-Gis позволяет создать как цветной вариант, 
 

 
 
так и монохромный. 
 

 
  

7.2. Редактирование карты и завершение проекта 
 
Если вы хотите включить карты в документы или отчеты, вы можете сделать комбина-

цию из созданных слоев, а также осуществить базовое редактирование (например, добавить 
масштаб, направление сторон света, текст и др.). 
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Для того чтобы перейти к карте, выберите закладку Data, затем для редактирования со-
зданной карты выберете вкладку Design, расположенную в правом нижнем углу экрана. Пере-
ход в эту вкладку позволяет редактировать визуализацию и сделать карту более информатив-
ной.  

 

 
 

После редактирования карты (используя опцию Map→Data tab) полученное изображение 
может быть сохранено в графическом формате с расширениями *.png, *.tif, *.bmp или скопиро-
вано непосредственно в буфер обмена.  

 

 



48 

7.3. Сохранение проекта в Diva-GIS 
 

 

Полученные и модифицированные в Diva-GIS векторные и растровые файлы сохраняют-
ся автоматически. Определенная комбинация файлов может быть сохранена как проект, кото-
рый определяется как сочетание различных растровых и векторных файлов. Если вы хотите 
вернуться к работе, следует просто повторно открыть проект. При этом автоматически откро-
ются все слои, которые составляют карту, так что вам не нужно будет создавать карту снова. 
Чтобы открыть проект, сохраненный ранее, используйте Project → Open. Чтобы сохранить 
проект, используйте соответствующий значок или выберите Project → Save as. Проект будет 
сохранен как файл *.div. Этот файл содержит информацию только о расположении каждого 
слоя в проекте, пути к этим данным, но не сами файлы. Таким образом, он может быть открыт 
только в том случае, если все требующиеся файлы находятся в тех же папках, в которых они 
находились при создании проекта. Если изменить расположение слоев (переместить, например, 
в другую папку, или объединить папки), программа нужных файлов не найдет и, следователь-
но, созданную ране карту не откроет. Чтобы извлечь этот файл со всеми составляющими слоя-
ми и переместить его, например, на съемный носитель, перейдите в Project → Export Project. 
Перед экспортом конвертируйте файл с расширением *.div в файл *.dix. Следует, однако, пом-
нить, что файл *.dix может иметь значительно больший объем в зависимости от его содержи-
мого (разрешения карт и количества слоев). Отдельные векторные и растровые файлы также 
могут быть извлечены и сохранены на съемный носитель, но при этом надо обязательно убе-
диться, что скопированы и сохранены все файлы, составляющие выбранный слой. Для вектор-
ных файлов необходимы три файла с расширениями *.shp, *.shx и *.dbf, а для растровых – *.grd 
и *.gri. Файлы изображений *.bpw и *.bmp генерируются автоматически при визуализации 
растрового файла, но не являются неотъемлемой частью файла.  

В заключение еще раз подчеркнем, что созданная модель распространения отражает 
только климатические преференции вида и не учитывает ни способов и возможностей распро-
странения вида, ни антропогенного воздействия, ни особенностей сбора материала. Более по-
дробную информацию о моделировании распространения видов, контроле качества вводимых 
данных и полученной модели можно найти в следующих пособиях и статьях, которые находят-
ся в свободном доступе в сети: 

 
Brown J.L. SDMtoolbox User Guide. SDMtoolbox, 2014. URL: http://www.sdmtoolbox.org (дата об-

ращения: 18.04.2016). 
Hijmans R.J., Guarino L. and Mathur P. DIVA-GIS Version 7.5 Manual, 2012. URL: http://diva-

gis.org/docs/DIVA-GIS_manual_7.pdf (дата обращения: 18.04.2016). 
Hijmans R.J., Guarino L., Jarvis A. et. al. DIVA-GIS Users manual., version 5.2. [Электронный 

ресурс] // Diva-GIS, 2005. URL: http://www.Diva-GIS Diva-GIS.org/DIVA-GIS DIVA-GIS 5_manual.pdf 
(дата обращения: 18.04.2016). 

Phillips S.J., AT&T. A brief tutorial on MaxEnt. URL: http://www.cs.princeton.edu/~schapire/ 
maxent/tutorial/tutorial.doc (дата обращения: 18.04.2016). 

Ramirez J., Bueno-Cabrera A. Working with climate data and niche modeling. Creation of bioclimatic 
variables. Tutorial, 2009. URL: http://gisweb.ciat.cgiar.org/GCMPage?docs?tutorial_bcvars_creation.pdf. (дата 
обращения: 18.04.2016). 

Scheldeman X., Van Zonneveld M. Training manual on spatial analysis of plant diversity and distribu-
tion. Biodiversity International. 2010. URL:  

http://www.bioversityinternational.org/e-library/publications/detail/training-manual-on-spatial-
analysis-of-plant-diversity-and-distribution (дата обращения: 18.04.2016). 

Shcheglovitova M., Anderson R.P. Estimation optimal complexity for ecological niche models: A jack-
knife approach for species with small sample sizes // Ecological Modelling. 2013. Vol. 269. P. 9–17. 

URL: https://www.researchgate.net/publication/259217968_Estimating_optimal_complexity_for_eco-
logical_niche_models_A_jackknife_approach_for_species_with_small_sample_sizes (дата обращения: 
18.04.2016). 
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